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Preface

PHP, which stands for "PHP: Hypertext Preprocessor" is a widely-used Open Source general-purpose
scripting language that is especially suited for Web development and can be embedded into HTML. Its
syntax draws upon C, Java, and Perl, and is easy to learn. The main goal of the language is to allow web
developers to write dynamically generated webpages quickly, but you can do much more with PHP.

This manual consists primarily of a function reference, but also contains a language reference,
explanations of some of PHP’s major features, and other supplemental information.

You can download this manual in several formats at http://www.php.net/docs.php. The downloads are
updated as the content changes. More information about how this manual is developed can be found in
the’About the manual’ appendix.
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What is PHP?

PHP (recursive acronym for "PHP: Hypertext Preprocessor") is a widely-used Open Source
general-purpose scripting language that is especially suited for Web development and can be embedded
into HTML.

Simple answer, but what does that mean? An example:
Example 1-1. An introductory example

<html>
<head>
<title>Example</title>
</head>
<body>

<?php
echo "Hi, I'm a PHP script!";
?>

</body>
</html>

Notice how this is different from a script written in other languages like Perl or C -- instead of writing a
program with lots of commands to output HTML, you write an HTML script with some embedded code
to do something (in this case, output some text). The PHP code is enclosed in/special start and end tags
that allow you to jump into and out of "PHP mode".

What distinguishes PHP from something like client-side JavaScript is that the code is executed on the
server. If you were to have a script similar to the above on your server, the client would receive the
results of running that script, with no way of determining what the underlying code may be. You can
even configure your web server to process all your HTML files with PHP, and then there’s really no way
that users can tell what you have up your sleeve.

The best things in using PHP are that it is extremely simple for a newcomer, but offers many advanced
features for a professional programmer. Don’t be afraid reading the long list of PHP’s features. You can
jump in, in a short time, and start writing simple scripts in a few hours.

Although PHP’s development is focused on server-side scripting, you can do much more with it. Read
on, and see more in the What can PHP|do? section.

What can PHP do?

Anything. PHP is mainly focused on server-side scripting, so you can do anything any other CGI
program can do, such as collect form data, generate dynamic page content, or send and receive cookies.
But PHP can do much more.
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There are three main fields where PHP scripts are used.

- Server-side scripting. This is the most traditional and main target field for PHP. You need three things
to make this work. The PHP parser (CGI or server module), a webserver and a web browser. You need
to run the webserver, with a connected PHP installation. You can access the PHP program output with
a web browser, viewing the PHP page through the server. See the installation instructions section for
more information.

Command line scripting. You can make a PHP script to run it without any server or browser. You only
need the PHP parser to use it this way. This type of usage is ideal for scripts regularly executed using
cron (on *nix or Linux) or Task Scheduler (on Windows). These scripts can also be used for simple
text processing tasks. See the section about Command line usage|of PHP for more information.

- Writing client-side GUI applications. PHP is probably not the very best language to write windowing
applications, but if you know PHP very well, and would like to use some advanced PHP features in
your client-side applications you can also use PHP-GTK to write such programs. You also have the
ability to write cross-platform applications this way. PHP-GTK is an extension to PHP, not available in
the main distribution. If you are interested in PHP-GTK, visit it's own website (http://gtk.php.net/).

PHP can be used on all major operating systems, including Linux, many Unix variants (including

HP-UX, Solaris and OpenBSD), Microsoft Windows, Mac OS X, RISC OS, and probably others. PHP

has also support for most of the web servers today. This includes Apache, Microsoft Internet Information
Server, Personal Web Server, Netscape and iPlanet servers, Oreilly Website Pro server, Caudium, Xitami,
OmniHTTPd, and many others. For the majority of the servers PHP has a module, for the others
supporting the CGI standard, PHP can work as a CGI processor.

So with PHP, you have the freedom of choosing an operating system and a web server. Furthermore, you
also have the choice of using procedural programming or object oriented programming, or a mixture of
them. Although not every standard OOP feature is realized in the current version of PHP, many code
libraries and large applications (including the PEAR library) are written only using OOP code.

With PHP you are not limited to output HTML. PHP’s abilities includes outputting images, PDF files

and even Flash movies (using libswf and Ming) generated on the fly. You can also output easily any text,
such as XHTML and any other XML file. PHP can autogenerate these files, and save them in the file
system, instead of printing it out, forming a server-side cache for your dynamic content.

One of the strongest and most significant feature in PHP is its support for a wide range of databases.
Writing a database-enabled web page is incredibly simple. The following databases are currently
supported:

Adabas D Ingres Oracle (OCI7 and OCI8)
dBase InterBase Ovrimos

Empress FrontBase PostgreSQL

FilePro (read-only) mSQL Solid

Hyperwave Direct MS-SQL Sybase

IBM DB2 MySQL Velocis

Informix ODBC Unix dbm

We also have a DBX database abstraction extension allowing you to transparently use any database
supported by that extension. Additionally PHP supports ODBC, the Open Database Connection standard,
S0 you can connect to any other database supporting this world standard.

PHP also has support for talking to other services using protocols such as LDAP, IMAP, SNMP, NNTP,
POP3, HTTP, COM (on Windows) and countless others. You can also open raw network sockets and
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interact using any other protocol. PHP has support for the WDDX complex data exchange between
virtually all Web programming languages. Talking about interconnection, PHP has support for
instantiation of Java objects and using them transparently as PHP objects. You can also use our CORBA
extension to access remote objects.

PHP has extremely useful text processing features, from the POSIX Extended or Perl regular expressions
to parsing XML documents. For parsing and accessing XML documents, we support the SAX and DOM
standards. You can use our XSLT extension to transform XML documents.

While using PHP in the ecommerce field, you'll find the Cybercash payment, CyberMUT, VeriSign
Payflow Pro and CCVS functions useful for your online payment programs.

At last but not least, we have many other interesting extensions, the mnoGoSearch search engine
functions, the IRC Gateway functions, many compression utilities (gzip, bz2), calendar conversion,
translation...

As you can see this page is not enough to list all the features and benefits PHP can offer. Read on in the
sections about installing PHP, and seel the function reference part for explanation of the extensions
mentioned here.
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Here we would like to show the very basics of PHP in a short simple tutorial. This text only deals with
dynamic webpage creation with PHP, though PHP is not only capable of creating webpages. See the
section titled What can PHP do for more information.

PHP-enabled web pages are treated just like regular HTML pages and you can create and edit them the
same way you normally create regular HTML pages.

What do | need?

In this tutorial we assume that your server has support for PHP activated and that all files englipg in

are handled by PHP. On most servers this is the default extension for PHP files, but ask your server
administrator to be sure. If your server supports PHP then you don’t need to do anything. Just create your
.php files and put them in your web directory and the server will magically parse them for you. There is
no need to compile anything nor do you need to install any extra tools. Think of these PHP-enabled files
as simple HTML files with a whole new family of magical tags that let you do all sorts of things.

Your first PHP-enabled page

Create a file namelkllo.php  under your webserver root directory with the following content:
Example 2-1. Our first PHP script: hel | 0. php

<htmlI>
<head>
<titte>PHP Test</title>

</head>

<body>

<?php echo "Hello World<p>"; ?>
</body>

</html>

The output of this script will be:

<htmlI>
<head>
<titte>PHP Test</title>
</head>
<body>
Hello World<p>
</body>
</html>
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Note that this is not like a CGI script. The file does not need to be executable or special in any way.
Think of it as a normal HTML file which happens to have a set of special tags available to you that do a
lot of interesting things.

This program is extremely simple and you really didn’t need to use PHP to create a page like this. All it
does is displayHello World  using the PHP echo() statement.

If you tried this example and it didn’t output anything, or it prompted for download, or you see the whole
file as text, chances are that the server you are on does not have PHP enabled. Ask your administrator to
enable it for you using the Installation chapter of the manual. If you want to develop PHP scripts locally,
see the downloads (http://www.php.net/downloads.php) section. You can develop locally on any
Operating system, be sure to install an appropriate web server too.

The point of the example is to show the special PHP tag format. In this example we2ptgdto
indicate the start of a PHP tag. Then we put the PHP statement and left PHP mode by adding the closing
tag,?>. You may jump in and out of PHP mode in an HTML file like this all you want.

Something Useful

Let's do something a bit more useful now. We are going to check what sort of browser the person
viewing the page is using. In order to do that we check the user agent string that the browser sends as
part of its HTTP request. This information is stored in a variable. Variables always start with a
dollar-sign in PHP. The variable we are interested in right no$v 82RVER["HTTP_USER_AGENT"]

PHP Autoglobals Note: '$ SERVER|is a special reserved PHP variable that contains all web server
information. It's known as an Autoglobal. See the related manual page on Autoglobals (also known
as Superglobals) for more information. These special variables were introduced in PHP 4.1.0. Before
this time, we used the older $HTTP_*_VARSarrays instead, such as $HTTP_SERVER_VARRAlthough
deprecated, these older variables still exist.

To display this variable, we can simply do:
Example 2-2. Printing a variable (Array element)

<?php echo $ SERVER['HTTP_USER_AGENT"]; ?>

A sample output of this script may be:
Mozilla/4.0 (compatible; MSIE 5.01; Windows NT 5.0)

There are many types of variables available in PHP. In the above example we printed an Array element.
Arrays can be very useful.
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$_SERVERIs just one variable that's automatically made available to you by PHP. A list can be seen in
the Reserved Variables section of the manual or you can get a complete list of them by creating a file that
looks like this:

Example 2-3. Show all predefined variables with phpinfo()

<?php phpinfo(); ?>

If you load up this file in your browser you will see a page full of information about PHP along with a
list of all the variables available to you.

You can put multiple PHP statements inside a PHP tag and create little blocks of code that do more than
just a single echo. For example, if we wanted to check for Internet Explorer we could do something like
this:

Example 2-4. Example using control structures and functions

<?php
if (strstr($_SERVER['"HTTP_USER_AGENT"], "MSIE")) {
echo "You are using Internet Explorer<br />";

}

?>

A sample output of this script may be:

You are using Internet Explorer<br />

Here we introduce a couple of new concepts. We have an if statement. If you are familiar with the basic
syntax used by the C language this should look logical to you. If you don’t know enough C or some other
language where the syntax used above is used, you should probably pick up any introductory PHP book
and read the first couple of chapters, or read the Language Reference part of the manual. You can find a
list of PHP books at http://www.php.net/books.php.

The second concept we introduced was the strstr() function caiil strstr() is a function built into PHP
which searches a string for another string. In this case we are looking®E" inside
$_SERVER['HTTP_USER_AGENT"} If the string is found, the function returmRUEand if it isn't, it
returnsFALSE. If it returnsTRUE the'if statement evaluates TRUEand the code within its {braces} is
executed. Otherwise, it's not. Feel free to create similar examples, with if, else, and other functions such
ag strtoupper() and strlen(). Each related manual page contains examples too.
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We can take this a step further and show how you can jump in and out of PHP mode even in the middle
of a PHP block:

Example 2-5. Mixing both HTML and PHP modes

<?php

if (strstr($_SERVER['"HTTP_USER_AGENT"], "MSIE")) {
>

<h3>strstr must have returned true</h3>
<center><b>You are using Internet Explorer</b></center>
<?php

} else {

?>

<h3>strstr must have returned false</h3>
<center><b>You are not using Internet Explorer</b></center>
<?php

}

?>

A sample output of this script may be:

<h3>strstr must have returned true</h3>
<center><b>You are using Internet Explorer</b></center>

Instead of using a PHP echo statement to output something, we jumped out of PHP mode and just sent
straight HTML. The important and powerful point to note here is that the logical flow of the script
remains intact. Only one of the HTML blocks will end up getting sent to the viewer depending on if
strstr() returnedRUEor FALSE In other words, if the strin@/ISIE was found or not.

Dealing with Forms

One of the most powerful features of PHP is the way it handles HTML forms. The basic concept that is
important to understand is that any form element in a form will automatically be available to your PHP
scripts. Please read the manual section on Variables from outside of PHP for more information and
examples on using forms with PHP. Here’s an example HTML form:

Example 2-6. A simple HTML form

<form action="action.php" method="POST">
Your name: <input type="text" name="name" />
Your age: <input type="text" name="age" />
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<input type="submit">
</form>

There is nothing special about this form. It is a straight HTML form with no special tags of any kind.
When the user fills in this form and hits the submit button,att®n.php  page is called. In this file
you would have something like this:

Example 2-7. Printing data from our form

Hi <?php echo $ POST['name"]; ?>.
You are <?php echo $ POST["age"]; ?> years old.

A sample output of this script may be:

Hi Joe.
You are 22 years old.

It should be obvious what this does. There is nothing more to it $TRPOST['name"”] and

$ POST['age"] variables are automatically set for you by PHP. Earlier we use@l tRERVER

autoglobal, now above we just introduced the $ POST autoglobal which contains all POST data. Notice
how themethodof our form is POST. If we used the methG&ET then our form information would live

inthe $ GET autoglobal instead. You may also use the $ REQUEST autoglobal if you don't care the
source of your request data. It contains a mix of GET, POST, COOKIE and FILE data. See also the
import_request_variables() function.

Using old code with new versions of PHP

Now that PHP has grown to be a popular scripting language, there are more resources out there that have
listings of code you can reuse in your own scripts. For the most part the developers of the PHP language
have tried to be backwards compatible, so a script written for an older version should run (ideally)

without changes in a newer version of PHP, in practice some changes will usually be needed.

Two of the most important recent changes that affect old code are:

« The deprecation of the olsHTTP_* VARSarrays (which need to be indicated as global when used
inside a function or method). The following autoglobal arfays were introduced in PHP 4.1.0. They are:
$ GET, $_POST, $_COOKIE $_SERVER$_ENV, $_REQUESTand$_SESSION. The older
$HTTP_*_VARSarrays, such as $HTTP_POST_VARS, still exist and have since PHP 3.

10
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- External variables are no longer registered in the global scope by default. In other words, as of PHP
4.2.0 (http://www.php.net/release_4_2_0.php) the PHP directive register_globtilbysdefault in
php.ini . The preferred method of accessing these values is via the autoglobal arrays mentioned
above. Older scripts, books, and tutorials may rely on this directive being on. If on, for example, one
could usesid from the URLhttp://www.example.com/foo.php?id=42 . Whether on or off,
$_GET[id] is available.

For more details on these changes, see the section on predefined variables and links therein.

What's next?

With what you know now you should be able to understand most of the manual and also the various
example scripts available in the example archives. You can also find other examples on the php.net
websites in the links section: http://www.php.net/links.php.

11
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General Installation Considerations

Before installing first, you need to know what do you want to use PHP for. There are three main fields
you can use PHP, as described inthe What can PHP do? section:

« Server-side scripting
- Command line scripting

« Client-side GUI applications

For the first and most common form, you need three things: PHP itself, a web server and a web browser.
You probably already have a web browser, and depending on your operating system setup, you may also
have a web server (eg. Apache on Linux or IS on Windows). You may also rent webspace at a company.
This way, you don't need to set up anything on your own, only write your PHP scripts, upload it to the
server you rent, and see the results in your browser. You can find a list of hosting companies at
http://hosts.php.net/.

While setting up the server and PHP on your own, you have two choices for the method of connecting
PHP to the server. For many servers PHP has a direct module interface (also called SAPI). These servers
include Apache, Microsoft Internet Information Server, Netscape and iPlanet servers. Many other servers
have support for ISAPI, the Microsoft module interface (OmniHTTPd for example). If PHP has no

module support for your web server, you can always use it as a CGI processor. This means you set up
your server to use the command line executable of RiHp.éxe on Windows) to process all PHP file
requests on the server.

If you are also interested to use PHP for command line scripting (eg. write scripts autogenerating some
images for you offline, or processing text files depending on some arguments you pass to them), you
always need the command line executable. For more information, read the section about writing
command line PHP applicatigns. In this case, you need no server and no browser.

With PHP you can also write client side GUI applications using the PHP-GTK extension. This is a
completely different approach than writing web pages, as you do not output any HTML, but manage
windows and objects within them. For more information about PHP-GTK, please visit the site dedicated
to this extension (http://gtk.php.net/). PHP-GTK is not included in the official PHP distribution.

From now on, this section deals with setting up PHP for web servers on Unix and Windows with server
module interfaces and CGI executables.

Downloading PHP, the source code, and binary distributions for Windows can be found at
http://www.php.net/. We recommend you to choose a mirror (http://www.php.net/mirrors.php) nearest to
you for downloading the distributions.

Unix/HP-UX installs

This section contains notes and hints specific to installing PHP on HP-UX systems.

Example 3-1. Installation Instructions for HP-UX 10

13
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From: paul_mckay@clearwater-it.co.uk
04-Jan-2001 09:49
(These tips are for PHP 4.0.4 and Apache v1.3.9)

So you want to install PHP and Apache on a HP-UX 10.20 box?

1. You need gzip, download a binary distribution from
http://hpux.connect.org.uk/ftp/hpux/Gnu/gzip-1.2.4a/gzip-1.2.4a-sd-10.20.depot.Z
uncompress the file and install using swinstall

2. You need gcc, download a binary distribution from
http://gatekeep.cs.utah.edu/ftp/hpux/Gnu/gcc-2.95.2/gcc-2.95.2-sd-10.20.depot.gz
gunzip this file and install gcc using swinstall.

3. You need the GNU binutils, you can download a binary distribution from
http://hpux.connect.org.uk/ftp/hpux/Gnu/binutils-2.9.1/binutils-2.9.1-sd-10.20.depot.gz
gunzip and install using swinstall.

4. You now need bison, you can download a binary distribution from
http://hpux.connect.org.uk/ftp/hpux/Gnu/bison-1.28/bison-1.28-sd-10.20.depot.gz
install as above.

5. You now need flex, you need to download the source from one of the
http://www.gnu.org mirrors. It is in the <filename>non-gnu</filename> directory of the ftp site.
Download the file, gunzip, then tar -xvf it. Go into the newly created flex

directory and do a ./configure, then a make, and then a make install

If you have errors here, it's probably because gcc etc. are not in your
PATH so add them to your PATH.

Right, now into the hard stuff.

6. Download the PHP and apache sources.

7. gunzip and tar -xvf them.

We need to hack a couple of files so that they can compile ok.

8. Firstly the configure file needs to be hacked because it seems to lose

track of the fact that you are a hpux machine, there will be a

better way of doing this but a cheap and cheerful hack is to put
It_target=hpux10.20

on line 47286 of the configure script.

9. Next, the Apache GuessOS file needs to be hacked. Under
apache_1.3.9/src/helpers change line 89 from

"echo "hp${HPUXMACH}-hpux${HPUXVER}"; exit 0"
to:

"echo "hp${HPUXMACH]}-hp-hpux${HPUXVER}"; exit 0"

10. You cannot install PHP as a shared object under HP-UX so you must compile
it as a static, just follow the instructions at the Apache page.

14



Chapter 3. Installation

11. PHP and apache should have compiled OK, but Apache won't start. you need
to create a new user for Apache, eg www, or apache. You then change lines 252
and 253 of the conf/httpd.conf in Apache so that instead of

User nobody

Group nogroup
you have something like

User www

Group sys

This is because you can’t run Apache as nobody under hp-ux.
Apache and PHP should then work.

Hope this helps somebody,
Paul Mckay.

Unix/Linux installs

This section contains notes and hints specific to installing PHP on Linux distributions.

Using Packages

Many Linux distributions have some sort of package installation system, such as RPM. This can assist in
setting up a standard configuration, but if you need to have a different set of features (such as a secure
server, or a different database driver), you may need to build PHP and/or your webserver. If you are
unfamiliar with building and compiling your own software, it is worth checking to see whether

somebody has already built a packaged version of PHP with the features you need.

Unix/Mac OS X installs

This section contains notes and hints specific to installing PHP on Mac OS X Server.

Using Packages

There are a few pre-packaged and pre-compiled versions of PHP for Mac OS X. This can help in setting
up a standard configuration, but if you need to have a different set of features (such as a secure server, or
a different database driver), you may need to build PHP and/or your web server yourself. If you are
unfamiliar with building and compiling your own software, it's worth checking whether somebody has
already built a packaged version of PHP with the features you need.

Compiling for OS X server

There are two slightly different versions of Mac OS X, client and server. The following is for OS X
Server.

15
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Example 3-2. Mac OS X server install

1. Get the latest distributions of Apache and PHP

2. Untar them, and run the configure program on Apache like so.
Jconfigure --exec-prefix=/usr \
--localstatedir=/var \
--mandir=/usr/share/man \
--libexecdir=/System/Library/Apache/Modules \
--iconsdir=/System/Library/Apache/lcons \
--includedir=/System/Library/Frameworks/Apache.framework/Versions/1.3/Headers \
--enable-shared=max \
--enable-module=most \
--target=apache

4. You may also want to add this line:
setenv. OPTIM=-02
If you want the compiler to do some optimization.

5. Next, go to the PHP 4 source directory and configure it.
Jconfigure --prefix=/usr \
--sysconfdir=/etc \
--localstatedir=/var \
--mandir=/usr/share/man \
--with-xml \
--with-apache=/src/apache_1.3.12

If you have any other additions (MySQL, GD, etc.), be sure to add
them here. For the --with-apache string, put in the path to your
apache source directory, for example "/src/apache_1.3.12".

6. make

7. make install
This will add a directory to your Apache source directory under
src/modules/php4.

8. Now, reconfigure Apache to build in PHP 4.
Jconfigure --exec-prefix=/usr \
--localstatedir=/var \

--mandir=/usr/share/man \

--libexecdir=/System/Library/Apache/Modules \
--iconsdir=/System/Library/Apache/lcons \
--includedir=/System/Library/Frameworks/Apache.framework/Versions/1.3/Headers \
--enable-shared=max \

--enable-module=most \

--target=apache \

--activate-module=src/modules/php4/libphp4.a

You may get a message telling you that libmodphp4.a is out of date.
If so, go to the src/modules/php4 directory inside your apache

source directory and run this command:

ranlib libmodphp4.a

16
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Then go back to the root of the apache source directory and run the
above configure command again. That'll bring the link table up to
date.

9. make
10. make install

11. copy and rename the php.ini-dist file to your "bin" directory from your
PHP 4 source directory:
cp php.ini-dist /usr/local/bin/php.ini

or (if your don't have a local directory)

cp php.ini-dist /usr/bin/php.ini

Other examples for Mac OS X client
(http://www.stepwise.com/Articles/Workbench/Apache-1.3.14-MacOSX.html) and Mac OS X server
(http://www.stepwise.com/Articles/Workbench/Apache-1.3.14-MacOSX.html) are available at Stepwise
(http://www.stepwise.com/).

Compiling for MacOS X client
Those tips are graciously provided by Marc Liyanage (http://www.entropy.ch/software/macosx/).

The PHP module for the Apache web server included in Mac OS X. This version includes support for the
MySQL and PostgreSQL databases.

NOTE: Be careful when you do this, you could screw up your Apache web server!

Do this to install:

« 1. Open a terminal window

.« 2. Type "wget http://www.diax.ch/users/liyanage/software/macosx/libphp4.so.gz", wait for download
to finish

3. Type "gunzip libphp4.so.gz"
- 4. Type "sudo apxs -i -a -n php4 libphp4.so"

Now type 'sudo open -a TextEdit /etc/httpd/httpd.conf " TextEdit will open with the web
server configuration file. Locate these two lines towards the end of the file: (Use the Find command)

#AddType application/x-httpd-php .php
#AddType application/x-httpd-php-source .phps

Remove the two hash marks)( then save the file and quit TextEdit.

Finally, type 'sudo apachectl graceful " to restart the web server.
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PHP should now be up and running. You can test it by dropping a file into your "Sites" folder which is
called "test.php". Into that file, write this linex?php phpinfo() ?> "

Now open upl27.0.0.1/~your_username/test.php in your web browser. You should see a status
table with information about the PHP module.

Unix/OpenBSD installs

This section contains notes and hints specific to installing PHP on OpenBSD (http://www.openbsd.org/).

Using Ports

This is the recommended method of installing PHP on OpenBSD, as it will have the latest patches and
security fixes applied to it by the maintainers. To use this method, ensure that you have a recent ports
tree (http://www.openbsd.org/ports.html). Then simply find out which flavors you wish to install, and
issue themake install command. Below is an example of how to do this.

Example 3-3. OpenBSD Ports Install Example

$ cd /usr/ports/www/php4
$ make show VARNAME=FLAVORS
(choose which flavors you want from the list)
$ env FLAVOR="imap gettext Idap mysql gd" make install
$ /usr/local/sbin/php4-enable

Using Packages

There are pre-compiled packages available for your release of OpenBSD (http://www.openbsd.org/).
These integrate automatically with the version of Apache installed with the OS. However, since there are
a large number of options (calléidvorg available for this port, you may find it easier to compile it from
source using the ports tree. Read the packages(7)
(http://Iwww.openbsd.org/cgi-bin/man.cgi?query=packages) manual page for more information in what
packages are available.

Unix/Solaris installs

This section contains notes and hints specific to installing PHP on Solaris systems.
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Required software

Solaris installs often lack C compilers and their related tools. The required software is as follows:

« gcc (recommended, other C compilers may work)
+ make
- flex
bison
- m4
- autoconf
.« automake
- perl
- gzip
- far

In addition, you will need to install (and possibly compile) any additional software specific to your
configuration, such as Oracle or MySQL.

Using Packages

You can simplify the Solaris install process by using pkgadd to install most of your needed components.

Installation on UNIX systems

This section will guide you through the general configuration and installation of PHP on Unix systems.
Be sure to investigate any sections specific to your platform or web server before you begin the process.

Prerequisite knowledge and software:

- Basic UNIX skills (being able to operate "make" and a C compiler, if compiling)
« An ANSI C compiler (if compiling)

. flex (for compiling)

« bison (for compiling)

« Aweb server

Any module specific components (such as gd, pdf libs, etc.)

There are several ways to install PHP for the Unix platform, either with a compile and configure process,
or through various pre-packaged methods. This documentation is mainly focused around the process of
compiling and configuring PHP.

19



Chapter 3. Installation

The initial PHP setup and configuration process is controlled by the use of the commandline options of
theconfigure  script. This page outlines the usage of the most common options, but there are many
others to play with. Check out the Complete list of configure options for an exhaustive rundown. There
are several ways to install PHP:

« As an Apache module
As an fhttpd module
- For use with AOLServer, NSAPI, phttpd, Pi3Web, Roxen, thttpd, or Zeus.

. As a CGl executable

Apache Module Quick Reference

PHP can be compiled in a number of different ways, but one of the most popular is as an Apache
module. The following is a quick installation overview.

Example 3-4. Quick Installation Instructions for PHP 4 (Apache Module Version)

gunzip apache_1.3.x.tar.gz
tar xvf apache_1.3.x.tar
gunzip php-x.x.x.tar.gz
tar xvf php-x.x.x.tar
cd apache_1.3.x
Jconfigure --prefix=/www
cd ../php-x.x.x
Jconfigure --with-mysql --with-apache=../apache_1.3.x --enable-track-vars
make
. make install
. cd ../apache_1.3.x
. Jconfigure --activate-module=src/modules/php4/libphp4.a
. make
. make install
. cd ../php-x.x.x
. cp php.ini-dist /usr/local/lib/php.ini
. Edit your httpd.conf or srm.conf file and add:
AddType application/x-httpd-php .php

©OoNTOA~®DNR
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18. Use your normal procedure for restarting the Apache server. (You must
stop and restart the server, not just cause the server to reload by
use a HUP or USR1 signal.)
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Building

When PHP is configured, you are ready to build the CGI executable. The commadedshould take
care of this. If it fails and you can’t figure out why, see the Problems section.

Installation on Windows systems

This section applies to Windows 95/98/Me and Windows NT/2000/XP. Do not expect PHP to work on 16
bit platforms such as Windows 3.1. Sometimes we refer to the supported Windows platforms as Win32.

There are two main ways to install PHP for Windows: either manually or by using the InstallShield
installer.

If you have Microsoft Visual Studio, you can also build PHP from the original source code.

Once you have PHP installed on your Windows system, you may also want to load various extensions for
added functionality.

Windows InstallShield

The Windows PHP installer available from the downloads page at http://www.php.net/, this installs the
CGil version of PHP and, for IIS, PWS, and Xitami, configures the web server as well. Also note, that
while the InstallShield installer is an easy way to make PHP work, it is restricted in many aspects, as
automatic setup of extensions for example is not supported.

Install your selected HTTP server on your system and make sure that it works.

Run the executable installer and follow the instructions provided by the installation wizard. Two types of
installation are supported - standard, which provides sensible defaults for all the settings it can, and
advanced, which asks questions as it goes along.

The installation wizard gathers enough information to set uptipani  file and configure the web

server to use PHP. For IS and also PWS on NT Workstation, a list of all the nodes on the server with
script map settings is displayed, and you can choose those nodes to which you wish to add the PHP script
mappings.

Once the installation has completed the installer will inform you if you need to restart your system,
restart the server, or just start using PHP.

Warning

Be aware, that this setup of PHP is not secure. If you would like to have a secure
PHP setup, you'd better go on the manual way, and set every option carefully. This
automatically working setup gives you an instantly working PHP installation, but it
is not meant to be used on online servers.

Manual Installation Steps

This install guide will help you manually install and configure PHP on your Windows webserver. You
need to download the zip binary distribution from the downloads page at http://www.php.net/. The
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original version of this guide was compiled by Bob Silva (mailto:bob_silva@mail.umesd.k12.or.us), and
can be found at http://www.umesd.k12.or.us/php/win32install.html.

This guide provides manual installation support for:

- Personal Web Server 3 and 4 or newer
- Internet Information Server 3 and 4 or newer
- Apache 1.3.x
« OmniHTTPd 2.0b1 and up
Oreilly Website Pro
.+ Xitami

- Netscape Enterprise Server, iPlanet

PHP 4 for Windows comes in two flavours - a CGl executable (php.exe), and several SAPI modules (for
example: phpdisapi.dll). The latter form is new to PHP 4, and provides significantly improved
performance and some new functionality.

Warning

The SAPI modules have been significantly improved in the 4.1 release, however,
you may find that you encounter possible server errors or other server modules
such as ASP failing, in older systems.

If you choose one of the SAPI modules and use Windows 95, be sure to download the DCOM update
from the Microsoft DCOM pages
(http://download.microsoft.com/msdownload/dcom/95/x86/en/dcom95.exe). For the ISAPI module, an
ISAPI 4.0 compliant Web server is required (tested on IIS 4.0, PWS 4.0 and 1IS 5.0). [ISNEINis
supported. You should download and install the Windows NT 4.0 Option Pack with 1IS 4.0 if you want
native PHP support.

The following steps should be performed on all installations before the server specific instructions.

- Extract the distribution file to a directory of your choiegphp\ is a good start. You probably do
not want to use a path in which spaces are included (for example: c:\program files\php is not a good
idea). Some web servers will crash if you do.

« You need to ensure that the DLLs which PHP uses can be found. The precise DLLs involved depend
on which web server you use and whether you want to run PHP as a CGI or as a server module.
php4ts.dll is always used. If you are using a server module (e.g. ISAPI or Apache) then you will
need the relevant DLL from theapi folder. If you are using any PHP extension DLLs then you will
need those as well. To make sure that the DLLs can be found, you can either copy them to the system
directory (e.gwinnt/system32  or windows/system ) or you can make sure that they live in the
same directory as the main PHP executable or DLL your web server will uselip.gxe |,
php4apache.dll ).
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The PHP binary, the SAPI modules, and some extensions rely on external DLLs for execution. Make
sure that these DLLs in the distribution exist in a directory that is in the Windows PATH. The best bet

to doitis to copy the files below into your system directory, which is typically:
c:\windows\system for Windows 9x/ME

c:\winnt\system32 for Windows NT/2000

c:\windows\system32 for Windows XP

The files to copy are:
phpats.dll  , if it already exists there, overwrite it
The files in your distribution’s 'dlls’ directory. If you have them already installed on your system, overwrite them

Download the latest version of the Microsoft Data Access Components (MDAC) for your platform,
especially if you use Microsoft Windows 9x/NT4. MDAC is available at
http://www.microsoft.com/data/.

- Copy your chosen ini file (see below) to your '%WINDOWS%’ directory on Windows 9x/Me or to
your '%SYSTEMROOT%'’ directory under Windows NT/2000/XP and renamephmini . Your

'%WINDOWS%' or '%SYSTEMROOT%' directory is typically:

c:\windows for Windows 9x/ME/XP
c\winnt  orc:\winnt40  for NT/2000 servers

There are two ini files distributed in the zip filehp.ini-dist andphp.ini-optimized . We

advise you to usphp.ini-optimized , because we optimized the default settings in this file for
performance, and security. The best is to study all the ini settings and set every element manually
yourself. If you would like to achieve the best security, then this is the way for you, although PHP
works fine with these default ini files.

- Edit your newphp.ini file:
You will need to change the ’extension_dir’ setting to point to your php-install-dir, or where you
have placed youshp_*.dll  files. ex:c:\php\extensions

If you are using OmniHTTPd, do not follow the next step. Set the 'doc_root’ to point to your
webservers document_root. For exampl&pache\htdocs or c:\webroot

Choose which extensions you would like to load when PHP starts. See the section about Windows
extensions, about how to set up one, and what is already built in. Note that on a new installation it is
advisable to first get PHP working and tested without any extensions before enabling them in

php.ini

On PWS and IIS, you can set theowscap.ini  to point to:
c:\windows\system\inetsrv\browscap.ini on Windows 9x/Me,
c:\winnt\system32\inetsrv\browscap.ini on NT/2000, and
c:\windows\system32\inetsrv\browscap.ini on XP.

Note that themibs directory supplied with the Windows distribution contains support files for
SNMP. This directory should be movedD®IVE:\usr\mibs  (DRIVE being the drive where PHP
is installed.)

If you're using NTFS on Windows NT, 2000 or XP, make sure that the user running the webserver
has read permissions to yophp.ini  (e.g. make it readable by Everyone).

- For PWS give execution permission to the webroot:
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Start PWS Web Manager
Edit Properties of the "Home"-Directory

Select the "execute"-Checkbox

Building from source

Before getting started, it is worthwhile answering the question: "Why is building on Windows so hard?"
Two reasons come to mind:

1. Windows does not (yet) enjoy a large community of developers who are willing to freely share their
source. As a direct result, the necessary investment in infrastructure required to support such
development hasn’t been made. By and large, what is available has been made possible by the
porting of necessary utilities from Unix. Don’t be surprised if some of this heritage shows through
from time to time.

2. Pretty much all of the instructions that follow are of the "set and forget" variety. So sit back and try
follow the instructions below as faithfully as you can.

Preparations

Before you get started, you have a lot to download...

- For starters, get the Cygwin toolkit from the closest cygwin
(http://sources.redhat.com/cygwin/download.html) mirror site. This will provide you most of the
popular GNU utilities used by the build process.

- Download the rest of the build tools you will need from the PHP site at
http://www.php.net/extra/win32build.zip.

- Get the source code for the DNS name resolver used by PHP at
http://iwww.php.net/extra/bindlib_w32.zip. This is a replacement fordhkelv.lib library included
in win32build.zip

- If you don't already have an unzip utility, you will need one. A free version is available from InfoZip
(http://www.cdrom.com/pub/infozip/UnZip.html).

- If you plan to compile PHP as a static Apache module you will also need the Apache sources
(http://httpd.apache.org/dist/httpd/) of your version of Apache.

Finally, you are going to need the source to PHP 4 itself. You can get the latest development version
using anonymous CVS (http://www.php.net/anoncvs.php). If you get a snapshot (http://snaps.php.net/) or
a source (http://www.php.net/downloads.php) tarball, you not only will have to untar and ungzip it, but
you will have to convert the bare linefeeds to crif’s in ttaésp and*.dsw files before Microsoft Visual

C++ will have anything to do with them.

Note: Place the Zend and TSRMdirectories inside the php4 directory in order for the projects to be
found during the build process.
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Putting it all together

Follow the instructions for installing the unzip utility of your choosing.

Executesetup.exe  and follow the installation instructions. If you choose to install to a path other
thanc:\cygnus , let the build process know by setting the Cygwin environment variable. On
Windows 95/98 setting an environment variable can be done by placing a line imytoagrec.bat

On Windows NT, go to My Computer => Control Panel => System and select the environment tab.

Warning

Make a temporary directory for Cygwin to use, otherwise many commands
(particularly bison) will fail. On Windows 95/98, nkdi r C: \ TMP. For Windows NT,
nkdir %SystenDrive%tnp.

Make a directory and unzigin32build.zip into it.

Launch Microsoft Visual C++, and from the menu select Tools => Options. In the dialog, select the
directories tab. Sequentially change the dropdown to Executables, Includes, and Library files, and
ensure thatygwin\bin , win32build\include , andwin32build\lib are in each list,

respectively. (To add an entry, select a blank line at the end of the list and begin typing). Typical
entries will look like this:

c:\cygnus\bin
c:\php-win32build\include
c:\php-win32build\lib

Press OK, and exit out of Visual C++.

Make another directory and unzipndlib_w32.zip into it. Decide whether you want to have
debug symbols available (bindlib - Win32 Debug) or not (bindlib - Win32 Release). Build the
appropriate configuration:

For GUI users, launch VC++, and then select File => Open Workspace and select bindlib. Then
select Build=>Set Active Configuration and select the desired configuration. Finally select
Build=>Rebuild All.

For command line users, make sure that you either have the C++ environment variables registered,
or have rurvcvars.bat, and then execute one of the following:

nsdev bindlib.dsp /MAKE "bindlib - Wn32 Debug"
nsdev bindlib.dsp /MAKE "bindlib - Wn32 Rel ease"

At this point, you should have a usabsolv.lib in either yourDebug or Release
subdirectories. Copy this file into yowin32build\lib directory over the file by the same name
found in there.
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Compiling

The best way to get started is to build the standalone/CGl version.

- For GUI users, launch VC++, and then select File => Open Workspace and select php4ts. Then select
Build=>Set Active Configuration and select the desired configuration. Finally select Build=>Rebuild
All.

- For command line users, make sure that you either have the C++ environment variables registered, or
have runvcvars.bat, and then execute one of the following:

nsdev php4ts.dsp / MAKE "php4ts - Wn32 Debug TS"
msdev php4ts.dsp / MAKE "php4dts - Wn32 Rel ease_TS"

At this point, you should have a usalpiep.exe in either yourDebug_TS or Release_TS
subdirectories.

Repeat the above steps withp4isapi.dsp ~ (which can be found isapilisapi ) in order to build the
code necessary for integrating PHP with Microsoft IIS.

It is possible to do minor customization to the build process by editing the main/config.win32.h.in file.

Installation of Windows extensions

After installing PHP and a webserver on Windows, you will probably want to install some extensions for
added functionality. The following table describes some of the extensions available. You can choose
which extensions you would like to load when PHP starts by uncommenting the: ’extension=php_*.dlI
lines inphp.ini . You can also load a module dynamically in your script using dl().

The DLLs for PHP extensions are prefixed with 'php_’ in PHP 4 (and 'php3_’ in PHP 3). This prevents
confusion between PHP extensions and their supporting libraries.

Note: In PHP 4.0.6 BCMath, Calendar, COM, FTP, MySQL, ODBC, PCRE, Session, WDDX and
XML support is built in. You don’t need to load any additional extensions in order to use these
functions. See your distributions README.txt or install.txt for a list of built in modules.

Note: Some of these extensions need extra DLLs to work. Couple of them can be found in the
distribution package, in the 'dlls’ folder but some, for example Oracle (php_oci8.dll) require DLLs
which are not bundled with the distribution package.

Copy the bundled DLLs from 'DLLs’ folder to your Windows PATH, safe places are:

c:\windows\system for Windows 9x/Me

c:\winnt\system32 for Windows NT/2000

c:\windows\system32 for Windows XP

If you have them already installed on your system, overwrite them only if something doesn’t work
correctly (Before overwriting them, it is a good idea to make a backup of them, or move them to
another folder - just in case something goes wrong).
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Extension Description Notes

php_bz2.dll bzipZ compression functions  |None

php_calendar.dll jCaIendar conversion functions Built in since PHP 4.0.3
php_cpdf.dll jCIibPDF‘ functions None

php_crack.dll ‘Crack functions None

php3_crypt.dll Crypt functions unknown

php_ctype.dll ctype family functions None

php_curl.dll ‘CURL, Client URL library Requires: libeay32.dll,

functions

ssleay32.dll (bundled)

php_cybercash.dll

Cybercash payment functions

None

php_db.dll ‘DBM functions Deprecated. Use DBA instead
(php_dba.dll)
php_dba.dll DBA! DataBase (dbm-style) None
Abstraction layer functions
php_dbase.dll dBaseé functions None
php3_dbm.dll Berkeley DB2 library unknown
php_domxml.dll DOM XML functions Requires: libxml2.dll (bundled)
php_dotnet.dll j.NET functions None
php_exif.dll jRead EXIF headers from JPEG |None
php_fbsql.dll jFrontBase functions None
php_fdf.dll FDF: Forms Data Format Requires: fdftk.dll (bundled)
functions.
php_filepro.dll jfiIePrc» functions Read-only access
php_ftp.dll jFTF‘ functions Built-in since PHP 4.0.3
php_gd.dll jGD library image functions None
php_gettext.dll ‘Gettext functions Requires: gnu_gettext.dll
(bundled)
php_hyperwave.dl| ‘HyperWave functions None

php_iconv.dll jICONV characterset conversionRequires: iconv-1.3.dll (bundled
php_ifx.dll ‘Informix functions Requires: Informix libraries
php_iisfunc.dll IIS management functions None

php_imap.dll IMAP/POP3 and NNTP function®HP 3: php3_imap4rl.dll
php_ingres.dll ‘Ingres Il functions Requires: Ingres Il libraries
php_interbase.dll jlnterBase functions Requires: gds32.dll (bundled)
php_java.dll jJava extension Requires: jvm.dll (bundled)
php_Ildap.dll ILDAP functions Requires: libsasl.dll (bundled)
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Extension Description Notes

php_mhash.dll Mhash Functions None

php_ming.dll ‘Ming functions for Flash None

php_msql.dll ‘mSQL. functions Requires: msql.dll (bundled)
php3_msqll.dll mSQL 1 client unknown

php3_msqgl2.dll mSQL 2 client unknown

php_mssql.dll MSSQL functions Requires: ntwdblib.dll (bundled)
php3_mysql.dil ‘MySQL functions Built-in in PHP 4
php3_nsmail.dll Netscape mail functions unknown

php3_oci73.dll Oracle functions unknown

php_oci8.dll Oracle 8 functions Requires: Oracle 8 client libraries
php_openssl.dll ‘OpenSSl_ functions Requires: libeay32.dll (bundled)
php_oracle.dll jOracIe functions Requires: Oracle 7 client libraries
php_pdf.dll jPDFi functions None

php_pgsql.dil ‘PostgreSQL functions None

php_printer.dll jPrinter functions None

php_xslt.dll jXSLT functions Requires: sablot.dll (bundled)
php_snmp.dll jSNMF‘ get and walk functions [NT only!

php_sybase_ct.dll ‘Sybase functions Requires: Sybase client libraries
php_yaz.dll jYAZ functions None

php_zlib.dll jZLib compression functions None

Servers-CGl/Commandline

The default is to build PHP as a CGI program. This creates a commandline interpreter, which can be
used for CGlI processing, or for non-web-related PHP scripting. If you are running a web server PHP has
module support for, you should generally go for that solution for performance reasons. However, the CGI
version enables Apache users to run different PHP-enabled pages under different user-ids. Please make
sure you read through the Security chapter if you are going to run PHP as a CGlI.

Testing

If you have built PHP as a CGI program, you may test your build by typiagie test It is always a
good idea to test your build. This way you may catch a problem with PHP on your platform early instead
of having to struggle with it later.

Benchmarking
If you have built PHP 3 as a CGI program, you may benchmark your build by typaig bench Note
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that if'Safe Mode is on by default, the benchmark may not be able to finish if it takes longer then the 30
seconds allowed. This is because|the set time | limit() can not be used in safe mode. Use the
max_execution time configuration setting to control this time for your own scrigtke benchignores

the| configuration file.

Note: make bench is only available for PHP 3.

Using Variables

Some server supplied enviroment variables are not defined in the current CGI/1.1 specification. Only the
following variables are defined there; everything else should be treated as 'vendor extensions’:
AUTH_TYPE, CONTENT_LENGTH, CONTENT_TYPE, GATEWAY_INTERFACE, PATH_INFO,
PATH_TRANSLATED, QUERY_STRING, REMOTE_ADDR, REMOTE_HOST, REMOTE_IDENT,
REMOTE_USER, REQUEST_METHOD, SCRIPT_NAME, SERVER_NAME, SERVER_PORT,
SERVER_PROTOCOL and SERVER_SOFTWARE

Servers-Apache

This section contains notes and hints specific to Apache installs of PHP, both for Unix and Windows
versions.

Details of installing PHP with Apache on Unix

You can select arguments to add to toafigure on line 8 below from the Complete list of configure
options. The version numbers have been omitted here, to ensure the instructions are not incorrect. You
will need to replace the 'xxx’ here with the correct values from your files.

Example 3-5. Installation Instructions (Apache Shared Module Version) for PHP 4

gunzip apache_xxx.tar.gz

tar -xvf apache_xxx.tar

gunzip php-xxx.tar.gz

tar -xvf php-xxx.tar

cd apache_xxx

Jconfigure --prefix=/www --enable-module=so
make

make install

. cd ../php-xxx

10. ./configure --with-mysql --with-apxs=/wwwi/bin/apxs
11. make

12. make install

©NoGOr®WNPE

If you decide to change your configure options after installation
you only need to repeat the last three steps. You only need to

29



Chapter 3. Installation

restart apache for the new module to take effect. A recompile of
Apache is not needed.

11. cp php.ini-dist /usr/local/lib/php.ini

You can edit your .ini file to set PHP options. If
you prefer this file in another location, use
--with-config-file-path=/path in step 8.

12. Edit your httpd.conf or srm.conf file and check that these lines are
present and not commented out:

AddType application/x-httpd-php .php
LoadModule php4_module libexec/libphp4.so

You can choose any extension you wish here. .php is simply the one
we suggest. You can even include .html, and .php3 can be added for
backwards compatibility.

The path on the right hand side of the LoadModule statement must point
to the path of the PHP module on your system. The above statement is
correct for the steps shown above.

13. Use your normal procedure for starting the Apache server. (You must
stop and restart the server, not just cause the server to reload by
use a HUP or USR1 signal.)

Depending on your Apache install and Unix variant, there are many possible ways to stop and restart the
server. Below are some typical lines used in restarting the server, for different apache/unix installations.
You should replacépath/to/  with the path to these applications on your systems.

1. Several Linux and SysV variants:
/etc/rc.d/init.d/httpd restart

2. Using apachectl scripts:
Ipath/to/apachectl stop
/path/to/apachectl start

3. httpdctl and httpsdctl (Using OpenSSL), similar to apachectl:
/path/to/httpsdctl stop
/path/to/httpsdctl start

4. Using mod_ssl, or another SSL server, you may want to manually
stop and start:

/path/to/apachectl stop

/path/to/apachectl startssl
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The locations of the apachectl and http(s)dctl binaries often vary. If your systelwch&s or
whereis orwhich commands, these can assist you in finding your server control programs.

Different examples of compiling PHP for apache are as follows:

Jconfigure --with-apxs --with-pgsql

This will create dibphp4.so  shared library that is loaded into Apache using a LoadModule line in
Apache’shttpd.conf  file. The PostgreSQL support is embedded intofihigp4.so  library.

Jconfigure --with-apxs --with-pgsql=shared

This will create dibphp4.so  shared library for Apache, but it will also creategsgl.so  shared
library that is loaded into PHP either by using the extension directipgprini  file or by loading it
explicitly in a script using the dl() function.

Jconfigure --with-apache=/path/to/apache_source --with-pgsql

This will create dibmodphp4.a  library, amod_php4.c and some accompanying files and copy this
into thesrc/modules/php4  directory in the Apache source tree. Then you compile Apache using
--activate-module=src/modules/php4/liophp4.a and the Apache build system will create
libphp4.a  and link it statically into thenttpd binary. The PostgreSQL support is included directly

into thishttpd binary, so the final result here is a singlepd binary that includes all of Apache and all
of PHP.

Jconfigure --with-apache=/path/to/apache_source --with-pgsql=shared

Same as before, except instead of including PostgreSQL support directly into thetfidal you will
get apgsqgl.so  shared library that you can load into PHP from eitherghgini  file or directly using

di().
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When choosing to build PHP in different ways, you should consider the advantages and drawbacks of
each method. Building as a shared object will mean that you can compile apache separately, and don't
have to recompile everything as you add to, or change, PHP. Building PHP into apache (static method)
means that PHP will load and run faster. For more information, see the Apache webpage on DSO support
(http://httpd.apache.org/docs/dso.html).

Note: Apache’s default http.conf currently ships with a section that looks like this:

User nobody
Group "#-1"

Unless you change that to "Group nogroup" or something like that ("Group daemon" is also very
common) PHP will not be able to open files.

Note: Make sure you specify the installed version of apxs when using --with-apxs=/path/to/apxs. You
must NOT use the apxs version that is in the apache sources but the one that is actually installed on
your system.

Installing PHP on Windows with Apache 1.3.x

There are two ways to set up PHP to work with Apache 1.3.x on Windows. One is to use the CGI binary
(php.exe), the other is to use the Apache module DLL. In either case you need to stop the Apache server,
and edit yousrm.conf or httpd.conf  to configure Apache to work with PHP.

It is worth noting here that now the SAPI module has been made more stable under windows, we
recommend it's use above the CGI binary, since it is more transparent and secure.

Although there can be a few variations of configuring PHP under Apache, these are simple enough to be
used by the newcomer. Please consult the Apache Docs for further configuration directives.

If you unziped the PHP package to c:\php\ as described in the Manual Installation Steps section, you
need to insert these lines to your Apache configuration file to set up the CGlI binary:

«  ScriptAlias /php/ "c:/php/"
« AddType application/x-httpd-php .php .phtml
Action application/x-httpd-php "/php/php.exe"

Note that the second line in the list above can be found in the actual versibtiysdofonf |, butiitis
commented out. Remember also to substitutectipgp/  for your actual path to PHP.

Warning

By using the CGI setup, your server is open to several possible attacks. Please
read our|CGlI security section to learn how to defend yourself from attacks.
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If you would like to use PHP as a module in Apache, be sure to mop4ts.dll to the
windows/system (for Windows 9x/Me) or winnt/system32 (for Windows NT/2000/XP) directory,
overwriting any older file. Then you should add the following two lines to you Apache conf file:

+ LoadModule php4_module c:/php/sapi/php4apache.dll
+ AddType application/x-httpd-php .php .phtml

After changing the configuration file, remember to restart the server, for exangpieSTOP APACHE
followed byNET START APACHHf you run Apache as a Windows Service, or use your regular
shortcuts.

Note: You may find after using the windows installer for Apache that you need to define the
AddModule directive for mod_php4.c in the configuration file (httpd.conf ). This is done by adding
AddModule mod_php4.c to the AddModule list, near the beginning of the configuration file. This is
especially important if the ClearModuleList directive is defined. Failure to do this may mean PHP
will not be registered as an Apache module.

There are 2 ways you can use the source code highlighting feature, however their ability to work depends
on your installation. If you have configured Apache to use PHP as an ISAPI module, then by adding the
following line to your configuration file you can use this featukddType

application/x-httpd-php-source .phps

If you chose to configure Apache to use PHP as a CGl binary, you will need to use the show_source()
function. To do this simply create a PHP script file and add this coefgip show_source
("original_php_script.php"); ?> . Substituteoriginal_php_script.php with the name of

the file you wish to show the source of.

Note: On Win-Apache all backslashes in a path statement such as "c:\directory\file.ext", must be
converted to forward slashes, as "c:/directory/file.ext".

Servers-Caudium

PHP 4 can be built as a Pike module for the Caudium webserver. Note that this is not supported with
PHP 3. Follow the simple instructions below to install PHP 4 for Caudium.

Example 3-6. Caudium Installation Instructions

1. Make sure you have Caudium installed prior to attempting to
install PHP 4. For PHP 4 to work correctly, you will need Pike
7.0.268 or newer. For the sake of this example we assume that
Caudium is installed in /opt/caudium/server/.
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2. Change directory to php-x.y.z (where x.y.z is the version number).
3. .Iconfigure --with-caudium=/opt/caudium/server
4. make
5. make install
6. Restart Caudium if it's currently running.
7. Log into the graphical configuration interface and go to the
virtual server where you want to add PHP 4 support.
8. Click Add Module and locate and then add the PHP 4 Script Support module.

9. If the documentation says that the 'PHP 4 interpreter isn’t
available’, make sure that you restarted the server. If you did
check /opt/caudium/logs/debug/default.1 for any errors related to
<filename>PHP4.so</filename>. Also make sure that
<filename>caudium/server/lib/[pike-version]/PHP4.so</flename>
is present.

10. Configure the PHP Script Support module if needed.

You can of course compile your Caudium module with support for the various extensions available in
PHP 4. See the complete list of configure options for an exhaustive rundown.

Note: When compiling PHP 4 with MySQL support you must make sure that the normal MySQL
client code is used. Otherwise there might be conflicts if your Pike already has MySQL support. You
do this by specifying a MySQL install directory the --with-mysql option.

Servers-fhttpd

To build PHP as an fhttpd module, answer "yes" to "Build as an fhttpd module?|' (the --with-fBitpd=
option to configure) and specify the fhitpd source base directory. The default directory is
Jusr/local/src/fhttpd . If you are running fhttpd, building PHP as a module will give better
performance, more control and remote execution capability.

Servers-1I1IS/PWS

This section contains notes and hints specific to 11S (Microsoft Internet Information Server). Installing
PHP for PWS/IIS 3, PWS 4 or newer and IIS 4 or newer versions.

Windows and PWS/IIS 3

The recommended method for configuring these servers is to use the REG file included with the
distribution (pws-php4cgi.reg). You may want to edit this file and make sure the extensions and PHP
install directories match your configuration. Or you can follow the steps below to do it manually.
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Warning

These steps involve working directly with the Windows registry. One error here can
leave your system in an unstable state. We highly recommend that you back up
your registry first. The PHP Development team will not be held responsible if you
damage your registry.

« Run Regedit.

- Navigate toHKEY_LOCAL_MACHINE /System /CurrentControlSet /Services /W3Svc
/Parameters /ScriptMap

« On the edit menu seledttew->String Value
Type in the extension you wish to use for your php scripts. For exarpige

- Double click on the new string value and enter the patbhtpexe in the value data field. ex:
c:\php\php.exe

- Repeat these steps for each extension you wish to associate with PHP scripts.

The following steps do not affect the web server installation and only apply if you want your php scripts
to be executed when they are run from the command line (exc:igscripts\test.php ) or by

double clicking on them in a directory viewer window. You may wish to skip these steps as you might
prefer the PHP files to load into a text editor when you double click on them.

- Navigate toHKEY_CLASSES ROOT

- On the edit menu seledttew->Key .

- Name the key to the extension you setup in the previous sectiomhgx:

- Highlight the new key and in the right side pane, double click the "default value" andptiptes
- Repeat the last step for each extension you set up in the previous section.

« Now create anotheMew->Key underHKEY_CLASSES_ROGAhd name iphpfile

Highlight the new keyhpfile  and in the right side pane, double click the "default value" and enter
PHP Script

- Right click on thephpfile  key and selediiew->Key, hame itShell
- Right click on theShell key and seledilew->Key, name itopen .
+ Right click on theopen key and seledilew->Key, name ittcommand

- Highlight the new keyrommandand in the right side pane, double click the "default value" and enter
the path tgphp.exe . ex:c:\php\php.exe -q %1 . (don't forget thevs?).

- Exit Regedit.

« If using PWS on Windows, reboot to reload the registry.
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PWS and IIS 3 users now have a fully operational system. 1IS 3 users can use a nifty tool
(http://lwww.genusa.com/iis/iiscfg.html) from Steven Genusa to configure their script maps.

Windows and PWS 4 or newer

When installing PHP on Windows with PWS 4 or newer version, you have two options. One to set up the
PHP CGI binary, the other is to use the ISAPI module DLL.

If you choose the CGI binary, do the following:

- Edit the enclosegdws-php4cgi.reg  file (look into the SAPI dir) to reflect the location of your
php.exe. Forward slashes should be escaped, for example:
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\w3svc\parameters\Script
Map] ".php"="c:\\php\\php.exe"

- Inthe PWS Manager, right click on a given directory you want to add PHP support to, and select
Properties. Check the 'Execute’ checkbox, and confirm.

If you choose the ISAPI module, do the following:

- Edit the enclose@dws-php4isapi.reg file (look into the SAPI dir) to reflect the location of your
php4isapi.dil. Forward slashes should be escaped, for example:
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\w3svc\parameters\Script
Map] ".php"="c:\\php\\sapi\\php4isapi.dil"

- Inthe PWS Manager, right click on a given directory you want to add PHP support to, and select
Properties. Check the 'Execute’ checkbox, and confirm.

Windows NT/2000/XP and IIS 4 or newer

To install PHP on an NT/2000/XP Server running IIS 4 or newer, follow these instructions. You have two
options to set up PHP, using the CGlI binary (php.exe) or with the ISAPI module.

In either case, you need to start the Microsoft Management Console (may appear as 'Internet Services
Manager’, either in your Windows NT 4.0 Option Pack branch or the Control Panel=>Administrative
Tools under Windows 2000/XP). Then right click on your Web server node (this will most probably
appear as 'Default Web Server’), and select 'Properties’.

If you want to use the CGI binary, do the following:

Under 'Home Directory’, 'Virtual Directory’, or 'Directory’, click on the 'Configuration’ button, and
then enter the App Mappings tab.

- Click Add, and in the Executable box, typeiphp\php.exe (assuming that you have unziped PHP
in c:\php\).

- In the Extension box, type the file name extension you want associated with PHP scripts. Leave
'Method exclusions’ blank, and check the Script engine checkbox. You may also like to check the
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‘check that file exists’ box - for a small performance penalty, IS (or PWS) will check that the script
file exists and sort out authentication before firing up php. This means that you will get sensible 404
style error messages instead of cgi errors complaining that php did not output any data.

You must start over from the previous step for each extension you want associated with PHP scripts.
.php and.phtml are common, althouglphp3 may be required for legacy applications.

- Set up the appropriate security. (This is done in Internet Service Manager), and if your NT Server
uses NTFS file system, add execute rights for |_USR__to the directory that copitpiage .

To use the ISAPI module, do the following:

- If you don't want to perform HTTP Authentication using PHP, you can (and should) skip this step.
Under ISAPI Filters, add a new ISAPI filter. Use PHP as the filter name, and supply a path to the
php4isapi.dil.

- Under 'Home Directory’, click on the 'Configuration’ button. Add a new entry to the Application
Mappings. Use the path to the php4isapi.dil as the Executable, syhplyas the extension, leave
Method exclusions blank, and check the Script engine checkbox.

« Stop IS completely (NET STOP iisadmin)
Start IS again (NET START w3svc)

Servers-Netscape and iPlanet

This section contains notes and hints specific to Netscape and iPlanet installs of PHP, both for Sun
Solaris and Windows versions.

You can find more information about setting up PHP for the Netscape Enterprise Server here:
http://benoit.noss.free.fr/phpl/install-php4.html

Installing PHP with Netscape on Sun Solaris

To build PHP with NES or iPlanet web servers, enter the proper install directory for the --with-nsapi =
DI Roption. The default directory is usuallypt/netscape/suitespot/ . Please also read
/php-xxx-version/sapi/nsapi/nsapi-readme.txt

Example 3-7. Installation Example for Netscape Enterprise on Solaris

Instructions for Sun Solaris 2.6 with Netscape Enterprise Server 3.6
From: bhager@invacare.com

1. Install the following packages from www.sunfreeware.com or another
download site:
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flex-2_5_4a-sol26-sparc-local
gce-2_95_2-sol26-sparc-local
gzip-1.2.4-sol26-sparc-local
perl-5_005_03-sol26-sparc-local
bison-1_25-s0l26-sparc-local
make-3_76_1-sol26-sparc-local
m4-1_4-sol26-sparc-local
autoconf-2.13

automake-1.4
mysql-3.23.24-beta (if you want mysql support)
tar-1.13 (GNU tar)

2. Make sure your path includes the proper directories
PATH=.:/usr/local/bin:/usr/sbin:/usr/bin:/usr/ccs/bin
export PATH

w

gunzip php-x.x.x.tar.gz (if you have a .gz dist, otherwise go to 4)
tar xvf php-x.x.x.tar
5. cd ../php-x.x.x

&

6. For the following step, make sure /opt/netscape/suitespot/ is where

your netscape server is installed. Otherwise, change to correct path:

/configure --with-mysql=/usr/local/mysql --with-nsapi=/opt/netscape/suitespot/ --enable-track-vars
7. make
8. make install

After performing the base install and reading the appropriate readme file, you may need to performs
some additional configuration steps.

Firstly you may need to add some paths to the LD_LIBRARY_PATH environment for Netscape to find
all the shared libs. This can best done in the start script for your Netscape server. Windows users can
probably skip this step. The start script is often located in:

Ipath/to/server/https-servername/start

You may also need to edit the configuration files that are located
in:/path/to/server/https-servername/config/

Example 3-8. Configuration Example for Netscape Enterprise

Configuration Instructions for Netscape Enterprise Server
From: bhager@invacare.com

1. Add the following line to mime.types:
type=magnus-internal/x-httpd-php exts=php

2. Add the following to obj.conf, shlib will vary depending on

your OS, for unix it will be something like
/opt/netscape/suitespot/bin/libphp4.so.
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You should place the following lines after mime types init.
Init fn="load-modules" funcs="php4_init,php4_close,php4_execute,php4_auth_trans" shlib="/php4/nsapiPHP4.dII"
Init fn=php4_init errorString="Failed to initialize PHP!"

<object name="default">

#NOTE this next line should happen after all 'ObjectType’ and before all 'AddLog’ lines
Service fn="php4_execute" type="magnus-internal/x-httpd-php"

</Object>

<Object name="x-httpd-php">

ObjectType fn="force-type" type="magnus-internal/x-httpd-php"

Service fn=php4_execute

</Object>

Authentication configuration

PHP authentication cannot be used with any other authentication. ALL AUTHENTICATION IS
PASSED TO YOUR PHP SCRIPT. To configure PHP Authentication for the entire server, add

the following line:

<Object name="default">
AuthTrans fn=php4_auth_trans

</Object>
To use PHP Authentication on a single directory, add the following:
<Object ppath="d:\path\to\authenticated\dir\*">

AuthTrans fn=php4_auth_trans
</Object>

If you are running Netscape Enterprise 4.x, then you should use the following:

Example 3-9. Configuration Example for Netscape Enterprise 4.x

Place these lines after the mime types init, and everything else is similar
to the example configuration above.
From: Graeme Hoose (GraemeHoose@BrightStation.com)

Init fn="load-modules" shlib="/path/to/server4/bin/libphp4.so" funcs="php4_init,php4_close,php4_execute,php4_auth_trans
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Init fn="php4_init" Latelnit="yes"

Installing PHP with Netscape on Windows

To Install PHP as CGl (for Netscape Enterprise Server, iPlanet, perhaps Fastrack), do the following:

«  Copyphp4ts.dll to your systemroot (the directory where you installed windows)

- Make a file association from the command line. Type the following two lines:

assoc .php=PHPScript
ftype PHPScript=c:\php\php.exe %1 %*

- Inthe Netscape Enterprise Administration Server create a dummy shellcgi directory and remove it
just after (this step creates 5 important lines in obj.conf and allow the web server to handle shellcgi
scripts).

« Inthe Netscape Enterprise Administration Server create a new mime type (Category: type,
Content-Type: magnus-internal/shellcgi, File Suffix:php).

- Do it for each web server instance you want php to run

More details about setting up PHP as a CGI executable can be found here:
http://benoit.noss.free.fr/php/install-php.html

To Install PHP as NSAPI (for Netscape Enterprise Server, iPlanet, perhaps Fastrack, do the following:

- Copyphp4ts.dil  to your systemroot (the directory where you installed windows)

- Make a file association from the command line. Type the following two lines:

assoc .php=PHPScript
ftype PHPScript=c:\php\php.exe %1 %*

« Inthe Netscape Enterprise Administration Server create a new mime type (Category: type,
Content-Type: magnus-internal/x-httpd-php, File Suffix:php).

Stop your web service and editj.conf . At the end of the Init section, place these two lines
(necessarily after mime type init!):

Init fn="load-modules" funcs="php4_init,php4_close,php4_execute,php4_auth_trans" shlib="c:/php/sapi/php4nsapi.dil"
Init fn="php4_init" errorString="Failed to initialise PHP!"

40



Chapter 3. Installation

« InThe< Object name="default" > section, place this line necessarily after all 'ObjectType’ and
before all ’AddLog’ lines:

Service fn="php4_execute" type="magnus-internal/x-httpd-php"

- At the end of the file, create a new object calielattpd-php , by inserting these lines:

<Object name="x-httpd-php">

ObjectType fn="force-type" type="magnus-internal/x-httpd-php"
Service fn=php4_execute

</Object>

- Restart your web service and apply changes
- Do it for each web server instance you want PHP to run

More details about setting up PHP as an NSAPI filter can be found here:
http://benoit.noss.free.fr/php/install-php4.html

Servers-OmniHTTPd Server

This section contains notes and hints specific to OmniHTTPd.

OmniHTTPd 2.0b1 and up for Windows

You need to complete the following steps to make PHP work with OmniHTTPd. This is a CGI
executable setup. SAPI is supported by OmniHTTPd, but some tests have shown that it is not so stable to
use PHP as an ISAPI module.

- Step 1: Install OmniHTTPd server.
- Step 2: Right click on the blue OmniHTTPd icon in the system tray and selegtrties
« Step 3: Click onweb Server Global Settings

Step 4: On the 'External’ tab, entesirtual = .php | actual =

c:\path-to-php-dir\php.exe , and use the Add button.
- Step 5: On thevime tab, entervirtual = wwwserver/stdcgi | actual = .php , and use the
Add button.

« Step 6: ClickOK

Repeat steps 2 - 6 for each extension you want to associate with PHP.
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Note: Some OmniHTTPd packages come with built in PHP support. You can choose at setup time to
do a custom setup, and uncheck the PHP component. We recommend you to use the latest PHP
binaries. Some OmniHTTPd servers come with PHP 4 beta distributions, so you should choose not
to set up the built in support, but install your own. If the server is already on your machine, use the
Replace button in Step 4 and 5 to set the new, correct information.

Servers-Oreilly Website Pro

This section contains notes and hints specific to Oreilly Website Pro.

Oreilly Website Pro 2.5 and up for Windows

This list describes how to set up the PHP CGlI binary or the ISAPI module to work with Oreilly Website
Pro on Windows.

- Edit the Server Properties and select the tab "Mapping".

- From the List select "Associations" and enter the desired extengign Y and the path to the CGI
exe (exc:\php\php.exe ) or the ISAPI DLL file (ex.c:\php\sapi\php4isapi.dll ).

Select "Content Types" add the same extensiap() and enter the content type. If you choose the
CGl executable file, enter 'wwwserver/shellcgi’, if you choose the ISAPI module, enter
‘wwwserver/isapi’ (both without quotes).

Servers-Xitami

This section contains notes and hints specific to Xitami.

Xitami for Windows

This list describes how to set up the PHP CGl binary to work with Xitami on Windows.

- Make sure the webserver is running, and point your browser to xitamis admin console (usually
http://127.0.0.1/admin ), and click on Configuration.

Navigate to the Filters, and put the extension which PHP should parse (i.e. .php) into the field File
extensions (.Xxx).

- In Filter command or script put the path and name of your php executabdepte\php.exe
« Press the 'Save’ icon.

- Restart the server to reflect changes.
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Servers-Other web servers

PHP can be built to support a large number of web servers. Please see Server-related options for a full list
of server-related configure options. The PHP CGI binaries are compatible with almost all webservers
supporting the CGI standard.

Problems?

Read the FAQ

Some problems are more common than others. The most common ones are listéd in the PHP FAQ, part
of this manual.

Other problems

If you are still stuck, someone on the PHP installation mailing list may be able to help you. You should
check out the archive first, in case someone already answered someone else who had the same problem
as you. The archives are available from the support page on http://www.php.net/. To subscribe to the PHP
installation mailing list, send an empty mail to php-install-subscribe @lists.php.net
(mailto:php-install-subscribe @lists.php.net). The mailing list address is

php-install@lists.php.net

If you want to get help on the mailing list, please try to be precise and give the necessary details about
your environment (which operating system, what PHP version, what web server, if you are running PHP
as CGl or a server module, etc.), and preferably enough code to make others able to reproduce and test
your problem.

Bug reports

If you think you have found a bug in PHP, please report it. The PHP developers probably don’t know
about it, and unless you report it, chances are it won'’t be fixed. You can report bugs using the
bug-tracking system at http://bugs.php.net/. Please do not send bug reports in mailing list or personal
letters. The bug system is also suitable to submit feature requests.

Read the How to report a bug (http://bugs.php.net/how-to-report.php) document before submitting any
bug reports!
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Complete list of configure options

Note: These are only used at compile time. If you want to alter PHP’s runtime configuration, please
see the chapter on|Configuration.

The following is a complete list of options supported by PHéddfigure  scripts (as of 4.1.0), used
when compiling in Unix-like environments. Some are available in PHP 3, some in PHP 4, and some in
both. This is not noted yet.

There are general configuration options for tieafigure script, consult the appropriate manual pages
for GNU autoconfor use the commancbnfigure --helpfor a full, up-to-date list.

- |Database

- Graphics

+ Miscellaneous
PHP Behaviour

« Server

« XML

Configure Options in PHP 4

Note: These options are only used in PHP 4 as of PHP 4.1.0. Some are available in older versions of
PHP 4, some even in PHP 3, some only in PHP 4.1.0. If you want to compile an older version, some
options will probably not be available.

Database options
--with-db
Include old xDBM support (deprecated).

- - enabl e- dba=shar ed

Build DBA as a shared module.
--wi t h-gdbn{ =Dl R]

Include GDBM support.
--wi t h-ndbn{ =DI R]

Include NDBM support.

--with-db2[ =Dl R]
Include Berkeley DB2 support.
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--with-db3[ =Dl R]

Include Berkeley DB3 support.
--with-dbn{ =Dl R]

Include DBM support.
--with-cdb[ =Dl R]

Include CDB support.
- - enabl e- dbase

Enable the bundled dbase library.
--w t h-dbpl us

Include dbplus support.
- - enabl e- dbx

Enable dbx.
--with-fbsql [=D R|

Include FrontBase support. DIR is the FrontBase base directory.
--enable-filepro

Enable the bundled read-only filePro support.
--with-fribidi[=DR]

Include fribidi support (requires FriBidi >=0.1.12). DIR is the fribidi installation directory - default
/usr/locall.

--with-inform x[=DI R

Include Informix support. DIR is the Informix base install directory, defaults to nothing.
--with-ingres[=D R

Include Ingres Il support. DIR is the Ingres base directory (default /ll/ingres).
--with-interbase[=DI R

Include InterBase support. DIR is the InterBase base install directory, defaults to /usr/interbase.
--with-nsql [ =D R]

Include mSQL support. DIR is the mSQL base install directory, defaults to /usr/local/Hughes.

--wi th-nysqgl [=DI R]

Include MySQL support. DIR is the MySQL base directory. If unspecified, the bundled MySQL
library will be used.
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--with-oci 8[=DI R]
Include Oracle-oci8 support. Default DIR is ORACLE_HOME.
--w t h-adabas[ =DI R]
Include Adabas D support. DIR is the Adabas base install directory, defaults to /usr/local.
--wi t h-sapdb[ =Dl R]
Include SAP DB support. DIR is SAP DB base install directory, defaults to /usr/local.
--with-solid[=DIR]
Include Solid support. DIR is the Solid base install directory, defaults to /usr/local/solid.
--wi th-i bm db2[=DI R
Include IBM DB2 support. DIR is the DB2 base install directory, defaults to /home/db2inst1/sqllib.
--with-enmpress[=DI R
Include Empress support. DIR is the Empress base install directory, defaults to SEMPRESSPATH.
From PHP4, this option only supports Empress Version 8.60 and above.
--wW t h-enpress-bcs[=DI R
Include Empress Local Access support. DIR is the Empress base install directory, defaults to
$EMPRESSPATH. From PHP4, this option only supports Empress Version 8.60 and above.
--w t h-birdstep[ =Dl R]

Include Birdstep support. DIR is the Birdstep base install directory, defaults to /usr/local/birdstep.

--wi th-custom odbc[ =DI R]

Include a user defined ODBC support. The DIR is ODBC install base directory, which defaults to
/usr/local. Make sure to define CUSTOM_ODBC_LIBS and have some odbc.h in your include dirs.
E.g., you should define following for Sybase SQL Anywhere 5.5.00 on QNX, prior to run configure
script: CPPFLAGS="-DODBC_QNX -DSQLANY_BUG" LDFLAGS=-lunix
CUSTOM_ODBC_LIBS="-ldblib -lodbc".

--with-iodbc[=D R
Include iODBC support. DIR is the iODBC base install directory, defaults to /usr/local.
--w t h-esoob[ =DI R]

Include Easysoft OOB support. DIR is the OOB base install directory, defaults to
/usr/local/easysoft/oob/client.

--wi t h-uni xODBC[ =DI R]
Include unixODBC support. DIR is the unixODBC base install directory, defaults to /usr/local.

--wi th-openlink[=DR]

Include OpenLink ODBC support. DIR is the OpenLink base install directory, defaults to
{usr/local. This is the same as iODBC.
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--wi t h-dbmaker [ =Dl R]
Include DBMaker support. DIR is the DBMaker base install directory, defaults to where the latest
version of DBMaker is installed (such as /home/dbmaker/3.6).

--with-oracl e[ =D R
Include Oracle-oci7 support. Default DIR is ORACLE_HOME.

--wi th-ovrinos[=DIR]

Include Ovrimos SQL Server support. DIR is the Ovrimos’ libsglcli install directory.

--wi th-pgsqgl [=DI R]
Include PostgreSQL support. DIR is the PostgreSQL base install directory, defaults to
/usr/local/pgsqgl. Set DIR to shared to build as a dl, or shared,DIR to build as a dl and still specify
DIR.

--w t h-sybase[ =DI R]
Include Sybase-DB support. DIR is the Sybase home directory, defaults to /home/sybase.

--with-sybase-ct[=DI R
Include Sybase-CT support. DIR is the Sybase home directory. Defaults to /home/sybase.

--di sabl e-uni fi ed- odbc

Disable unified ODBC support. Only applicable if iODBC, Adabas, Solid, Velocis or a custom
ODBC interface is enabled. PHP 3 only!

Graphics options

--With-gd[=DIR]

Include GD support (DIR is GD’s install dir). Set DIR to shared to build as a dl, or shared,DIR to
build as a dl and still specify DIR.

--enabl e-gd-native-ttf

GD: Enable TrueType string function in gd.

--with-jpeg-dir=DR
GD: Set the path to libjpeg install prefix.

--w th-png-dir=DI R
GD: Set the path to libpng install prefix.

--with-xpmdir=DR
GD: Set the path to libXpm install prefix.
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--with-freetype-dir=D R

GD: Set the path to freetype?2 install prefix.
--with-ttf[=DIR]

GD: Include FreeType 1.x support.
--with-t1llib[=DI R

GD: Include T1lib support.
--with-cpdflib[=DR

Include cpdflib support (requires cpdflib >= 2). DIR is the cpdfllib install directory, defaults to /usr.
--with-jpeg-dir[=D R

jpeg dir for cpdflib 2.x.
--with-tiff-dir[=D R

tiff dir for cpdflib 2.x.
--with-pdflib[=DR]

Include PDFIib support. DIR is the pdflib base install directory, defaults to /usr/local. Set DIR to
shared to build as dl, or shared,DIR to build as dl and still specify DIR.

--wWi th-jpeg-dir[=DR]

PDFLIB: define libjpeg install directory.
--with-png-dir[=DIR]

PDFLIB: define libpng install directory.
--with-tiff-dir[=DR]

PDFLIB: define libtiff install directory.
--wi th-swf[=DI R]

Include swf support.
--w t hout - gd

Disable GD support. PHP 3 only!

--w th-imagi ck

Include ImageMagick support. DIR is the install directory, and if left out, PHP will try to find it on
its own. [experimental]. PHP 3 only!

--with-mng[ =D R|

Include ming support.
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Misc options

--enabl e-force-cgi -redirect

Enable the security check for internal server redirects. You should use this if you are running the
CGil version with Apache.

- -enabl e-di scard- pat h

If this is enabled, the PHP CGI binary can safely be placed outside of the web tree and people will
not be able to circumvent .htaccess security.

--wi t h-fastcgi =SRCDI R
Build PHP as FastCGI application.

- - enabl e- debug

Compile with debugging symbols.

--with-layout =TYPE
Sets how installed files will be laid out. Type is one of PHP (default) or GNU.

--with-pear=D R
Install PEAR in DIR (default PREFIX/lib/php).

--W t hout - pear
Do not install PEAR.

--wi th-openssl| [=DI R]
Include OpenSSL support (requires OpenSSL >= 0.9.5).

--enabl e-sigchild

Enable PHP’s own SIGCHLD handler.

--di sabl e-rpath

Disable passing additional runtime library search paths.

--enabl e-1i bgcc

Enable explicitly linking against libgcc.

--enabl e-dnal | oc

Enable dmalloc.

- -enabl e- php- streans

Include experimental php streams. Do not use unless you are testing the code!

--with-zlib-dir=<DR>

Define the location of zlib install directory.
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--with-zlib[=DIR]
Include zlib support (requires zlib >=1.0.9). DIR is the zlib install directory.
--with-aspel | [=DI R
Include ASPELL support.

--enabl e-bcmat h

Enable bc style precision math functions.
--with-bz2[ =Dl R]
Include BZip2 support.

- -enabl e- cal endar

Enable support for calendar conversion.
--with-ccvs[=DIR]

Include CCVS support.
--with-crack[=D R

Include crack support.

--enabl e-ctype

Enable ctype support.
--with-curl[=DI R
Include CURL support.
--w t h-cyber cash[ =DI R]
Include CyberCash support. DIR is the CyberCash MCK install directory.
--with-cybernut[ =Dl R]
Include CyberMut (French Credit Mutuel telepaiement).
--wi th-cyrus
Include cyrus IMAP support.

--enabl e-exi f

Enable exif support.

--with-fdftk[=DIR]
Include fdftk support.

--enable-ftp
Enable FTP support.
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--with-gettext[=DR]
Include GNU gettext support. DIR is the gettext install directory, defaults to /usr/local.

--with-gnp
Include gmp support.

--wi t h- hyperwave

Include Hyperwave support.
--with-icap[=D R

Include ICAP support.
--with-iconv[=DR|

Include iconv support.
--with-imap[=DI R]

Include IMAP support. DIR is the c-client install prefix.
--with-kerberos[=DR]

IMAP: Include Kerberos support. DIR is the Kerberos install dir.
--wW th-imap-ssl [ =Dl R]

IMAP: Include SSL support. DIR is the OpenSSL install dir.
--with-ircg-config

Path to the ircg-config script.
--with-ircg

Include ircg support.
--with-java[=DI R]

Include Java support. DIR is the base install directory for the JDK. This extension can only be built
as a shared dl.

--with-ldap[=DI R]
Include LDAP support. DIR is the LDAP base install directory.

--enabl e- mai | par se

Enable mailparse support.

--enabl e-nbstring

Enable multibyte string support.

--enabl e-nbstr-enc-trans

Enable japanese encoding translation.
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--with-ntal [=DIR]

Include MCAL support.
--with-ncrypt [ =Dl R

Include mcrypt support. DIR is the mcrypt install directory.
--wi t h-nmhash[ =Dl R|

Include mhash support. DIR is the mhash install directory.
--w t h- nmogosear ch[ =DI R]

Include mnoGoSearch support. DIR is the mnoGoSearch base install directory, defaults to
/usr/local/mnogosearch.

--w th-nuscat[ =D R]
Include muscat support.

--w t h-ncur ses

Include ncurses support.

--enabl e- pcnt |
Enable experimental pcntl support (CGl ONLY!)
--w t hout - pcre-regex

Do not include Perl Compatible Regular Expressions support. Use --with-pcre-regex=DIR to
specify DIR where PCRE's include and library files are located, if not using bundled library.

--wi th-pfpro[=DR]

Include Verisign Payflow Pro support.

- - di sabl e- posi x

Disable POSIX-like functions.
--with-pspel | [=DI R

Include PSPELL support.
--w th-qtdom

Include QtDOM support (requires Qt >=2.2.0).
--with-libedit[=DR]

Include libedit readline replacement.

--with-readline[ =Dl R]

Include readline support. DIR is the readline install directory.
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--with-recode[ =DI R

Include recode support. DIR is the recode install directory.
--with-satellite[=DI R

Enable CORBA support via Satellite (EXPERIMENTAL) DIR is the base directory for ORBIt.
--with-mi =Dl R]

Include mm support for session storage.

--enabl e-trans-sid

Enable transparent session id propagation.

- -di sabl e- sessi on

Disable session support.

- -enabl e- shnop
Enable shmop support.
--with-snmp[=DI R]

Include SNMP support. DIR is the SNMP base install directory, defaults to searching through a
number of common locations for the snmp install. Set DIR to shared to build as a dI, or shared,DIR
to build as a dl and still specify DIR.

- - enabl e- ucd- snnp- hack
Enable UCD SNMP hack.

--enabl e- socket s

Enable sockets support.

--w t h-regex=TYPE
regex library type: system, apache, php.

--w th-systemregex

Use system regex library (deprecated).

--enabl e- sysvsem

Enable System V semaphore support.

--enabl e- sysvshm

Enable the System V shared memory support.

--wi th-vpopnail [ =Dl R]

Include vpopmail support.
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--wW th-tsrmpthreads
Use POSIX threads (default).

- - enabl e- shar ed[ =PKGS]

Build shared libraries [default=yes].

--enabl e- st ati c[ =PKGS]

Build static libraries [default=yes].

--enabl e-fast-instal | [ =PKGS]

Optimize for fast installation [default=yes].
--with-gnu-1d

Assume the C compiler uses GNU |d [default=no0].
--di sabl e-1ibtool -1ock

Avoid locking (might break parallel builds).
--with-pic

Try to use only PIC/non-PIC objects [default=use both].
--w th-yaz[ =Dl R]

Include YAZ support (ANSI/NISO Z39.50). DIR is the YAZ bin install directory.
--enabl e-nenory-1limt

Compile with memory limit support.

--di sabl e-url - f open-w apper

Disable the URL-aware fopen wrapper that allows accessing files via HTTP or FTP.

- - enabl e-ver si oni ng

Export only required symbols. See INSTALL for more information.

--di sabl e-bcmat h

Compile without bc style precision math functions. PHP 3 only!
--with-inmsp[ =D R]

Include IMSp support (DIR is IMSP’s include dir and libimsp.a dir). PHP 3 only!
--with-ftp

Include FTP support. PHP 3 only!
--wi t h-ntk[ =Dl R]

Include Cybercash MCK support. DIR is the cybercash mck build directory, defaults to
/usr/src/mck-3.2.0.3-linux for help look in extra/cyberlib. PHP 3 only!
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--di sabl e- over | oad

Disable user-space object overloading support. PHP 3 only!

--enabl e-yp
Include YP support. PHP 3 only!

--with-zip
Include ZIP support (requires zziplib >= 0.10.6). PHP 3 only!

--w t h- nod- dav=DI R

Include DAV support through Apache’s mod_dav, DIR is mod_dav’s installation directory (Apache
module version only!) PHP 3 only!

- - enabl e- debugger

Compile with remote debugging functions. PHP 3 only!

- - enabl e-ver si oni ng

Take advantage of versioning and scoping provided by Solaris 2.x and Linux. PHP 3 only!

PHP options
- - enabl e- mai nt ai ner - node
Enable make rules and dependencies not useful (and sometimes confusing) to the casual installer.

--with-config-fil e-pat h=PATH
Sets the path in which to look f@hp.ini , defaults to PREFIX/lib.

- - enabl e- saf e- nmode

Enable safe mode by default.

--w th-exec-dir[ =Dl R]

Only allow executables in DIR when in safe mode defaults to /usr/local/php/bin.

- -enabl e- nagi c- quot es

Enable magic quotes by default.

--di sabl e-short-tags

Disable the short-form <? start tag by default.

Server options

--wi t h-aol server=DI R

Specify path to the installed AOLserver.
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--wi t h-apxs[ =FI LE]

Build shared Apache module. FILE is the optional pathname to the Apache apxs tool; defaults to
apxs. Make sure you specify the version of apxs that is actually installed on your system and NOT
the one that is in the apache source tarball.

--wi th-apache[ =DI R

Build Apache module. DIR is the top-level Apache build directory, defaults to /usr/local/apache.
--wW t h-nod_char set
Enable transfer tables for mod_charset (Rus Apache).

--w t h-apxs2[ =FI LE]

Build shared Apache 2.0 module. FILE is the optional pathname to the Apache apxs tool; defaults
to apxs.

--with-fhttpd[ =D R|
Build fhttpd module. DIR is the fhttpd sources directory, defaults to /usr/local/src/fhttpd.
--with-isapi =DIR
Build PHP as an ISAPI module for use with Zeus.
--with-nsapi =DI R
Specify path to the installed Netscape Server.
--w t h-phtt pd=DI R
No information yet.
--w t h-pi 3web=DI R
Build PHP as a module for use with Pi3Web.

--wi th-roxen=DI R

Build PHP as a Pike module. DIR is the base Roxen directory, normally /usr/local/roxen/server.

--enabl e-roxen- zts
Build the Roxen module using Zend Thread Safety.
--with-servlet[=D R

Include servlet support. DIR is the base install directory for the JSDK. This SAPI preregs the java
extension must be built as a shared dl.

--wi th-thttpd=SRCDI R
Build PHP as thttpd module.

--w t h-t ux=MODULEDI R
Build PHP as a TUX module (Linux only).
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XML options
--w t h-don{ =DI R]
Include DOM support (requires libxml >=2.4.2). DIR is the libxml install directory, defaults to /usr.

- -di sabl e- xni
Disable XML support using bundled expat lib.

--wW th-expat-di r=DIR

XML.: external libexpat install dir.

--with-xmrpc[ =D R
Include XMLRPC-EPI support.

- - enabl e- wddx
Enable WDDX support.
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The configuration file

The configuration file (calleghp3.ini  in PHP 3.0, and simplphp.ini  as of PHP 4.0) is read when
PHP starts up. For the server module versions of PHP, this happens only once when the web server is
started. For the CGI and CLI version, it happens on every invocation.

The default location ofhp.ini  is a compile time option (see the FAQ entry), but can be changed for
the CGI and CLI version with the command line switch, see the chapter about usingfrom the
command lin2. You can also use the environment varigblleRCfor an additionaly path to search for
php.ini

Not every PHP directive is documented below. For a list of all directives, please read your well
commenteghp.ini  file. You may want to view the latest php.ini here
(http://cvs.php.net/co.php/php4/php.ini-dist) from CVS.

Note: The default value for the PHP directive [register_globals changed from on to off in PHP 4.2.0
(http://www.php.net/release_4_2_0.php).

Example 4-1.php. i ni example

; any text on a line after an unquoted semicolon (;) is ignored

[php] ; section markers (text within square brackets) are also ignored
;. Boolean values can be set to either:

; true, on, yes

; or false, off, no, none

register_globals = off

magic_quotes_gpc = yes

; you can enclose strings in double-quotes
include_path = ".:/usr/local/lib/php"

; backslashes are treated the same as any other character
include_path = ".;c:\php\lib"

When using PHP as an Apache module, you can also change the configuration settings using directives
in Apache configuration files and .htaccess files (You will need "AllowOverride Options" or
"AllowOverride All" privileges)

With PHP 3.0, there are Apache directives that correspond to each configuration settinghipitire
name, except the name is prefixed by "php3_".

With PHP 4.0, there are several Apache directives that allow you to change the PHP configuration from
within the Apache configuration file itself.

php_valuenane val ue

This sets the value of the specified variable.
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php_flagnamne on| of f

This is used to set a Boolean configuration option.

php_admin_valueane val ue

This sets the value of the specified variable. "Admin" configuration settings can only be set from
within the main Apache configuration files, and not from .htaccess files.

php_admin_flagnane on| of f

This is used to set a Boolean configuration option.

Example 4-2. Apache configuration example

<IfModule mod_php4.c>
php_value include_path ".:/usr/local/lib/php"
php_admin_flag safe_mode on
</IfModule>
<IfModule mod_php3.c>
php3_include_path ".:/usr/local/lib/php"
php3_safe_mode on
</IfModule>

Note: PHP constants do not exist outside of PHP. For example, in httpd.conf do not use PHP
constants such as E_ALL or E_NOTICEto set the lerror_reporting directive as they will have no
meaning and will evaluate to 0. Use the associated bitmask values instead. These constants can be
used in php.ini

You can view the settings of the configuration values in the output of phipinfo(). You can also access the
values of individual configuration settings using ini_get() or get_cfg_var().

General Configuration Directives

al | ow_ur | _f open boolean

This option enables the URL-aware fopen wrappers that enable accessing URL object like files.
Default wrappers are provided for the access of remote files using the ftp or http protocol, some
extensions like zlib may register additional wrappers.

Note: This option was introduced immediately after the release of version 4.0.3. For versions up
to and including 4.0.3 you can only disable this feature at compile time by using the
configuration switch |- - di sabl e-url -f open-w apper |
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Warning

On Windows, the following functions do not support remote file
accesing: linclude(), linclude once(), require() and |require_once().

asp_t ags boolean

Enables the use of ASP-like <% %> tags in addition to the usual <?php ?> tags. This includes the
variable-value printing shorthand of <%= $value %>. For more information, see Escapirig from
HTML!

Note: Support for ASP-style tags was added in 3.0.4.

aut o_append_fi | e string

Specifies the name of a file that is automatically parsed after the main file. The file is included as if
it was called with thé include() function, 50 include_path is used.

The special value none disables auto-appending.

Note: If the script is terminated with lexit(), auto-append will not occur.

aut o_prepend_fil e string

Specifies the name of a file that is automatically parsed before the main file. The file is included as
if it was called with the include() function, $o include_gath is used.

The special value none disables auto-prepending.

di sabl e_f uncti ons string

This directive allows you to disable certain functions for security reasons. It takes on a
comma-dilimited list of function names. disable_functions is not affected by SafelMode.

This directive must be set php.ini  For example, you cannot set thistitipd.conf

di spl ay_errors boolean

This determines whether errors should be printed to the screen as part of the HTML output or not.
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doc_r oot string

PHP’s "root directory” on the server. Only used if non-empty. If PHP is configured with safe mode,
no files outside this directory are served.

engi ne boolean

This directive is really only useful in the Apache module version of PHP. It is used by sites that
would like to turn PHP parsing on and off on a per-directory or per-virtual server basis. By putting
engi ne of f inthe appropriate places in thepd.conf  file, PHP can be enabled or disabled.

error _| og string

Name of file where script errors should be logged. If the special \s3kleg is used, the errors
are sent to the system logger instead. On UNIX, this means syslog(3) and on Windows NT it means
the event log. The system logger is not supported on Windows 95.

error_reporting integer

Set the error reporting level. The parameter is either an integer representing a bit field, or named
constants. The error_reporting levels and constants are described in the Error Handling section of
the manual, and iphp.ini . To set at runtime, use the error_reporting() function. See also the
display_errors directive.

The default value does not sh@&vNOTICElevel errors. You may want to show them during
development.

fil e_upl oads boolean

Whether or not to allow HTTP file uploads. See alsa the upload_max_filesize, upload_tmp_dir, and
post_max_size directives.

ht M _errors boolean

Turn off HTML tags in error messages. The new format for html errors produces clickable
messages that direct the user to a page describing the error or function in causing the error. These
references are affected by docref oot and docref ext.

docr ef _root string

The new error format contains a reference to a page describing the error or function in causing the
error. In case of manual pages you can download the manual in your language and set this ini
directive to the url of your local copy. If your local copy of the manual can be reached by '/manual/’
you can simply uselocr ef _r oot =/ manual / . Additional you have to set docref_ext to match

the fileextensions of your comjocr ef _ext =. ht m . It is possible to use external references. For
example you can usgocr ef _root =http:// manual / en/.

Note: The value of docref_root must end with a slash '/'.
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docr ef _ext string

See docref root.

Note: The value of docref_ext must begin with a dot ’..

open_basedi r string
Limit the files that can be opened by PHP to the specified directory-tree.

When a script tries to open a file with, for example, fopen or gzopen, the location of the file is
checked. When the file is outside the specified directory-tree, PHP will refuse to open it. All
symbolic links are resolved, so it's not possible to avoid this restriction with a symlink.

The special value . indicates that the directory in which the script is stored will be used as
base-directory.

Under Windows, separate the directories with a semicolon. On all other systems, separate the
directories with a colon. As an Apache module, open_basedir paths from parent directories are now
automatically inherited.

The restriction specified with open_basedir is actually a prefix, not a directory name. This means
that "open_basedir = /dir/incl" also allows access to "/dir/include" and "/dir/incls" if they exist.
When you want to restrict access to only the specified directory, end with a slash. For example:
"open_basedir = /dir/incl/"

Note: Support for multiple directories was added in 3.0.7.

The default is to allow all files to be opened.

gpc_or der string

Set the order of GET/POST/COOKIE variable parsing. The default setting of this directive is
"GPC". Setting this to "GP", for example, will cause PHP to completely ignore cookies and to
overwrite any GET method variables with POST-method variables of the same name.

Note, that this option is not available in PHP 4. Use variables order instead.

vari abl es_order string

Set the order of the EGPCS (Environment, GET, POST, Cookie, Server) variable parsing. The
default setting of this directive is "EGPCS". Setting this to "GP", for example, will cause PHP to
completely ignore environment variables, cookies and server variables, and to overwrite any GET
method variables with POST-method variables of the same name.

See also register_globals.
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i gnore_user _abort boolean

TRUEDby default. If changed tBALSE scripts will be terminated as soon as they try to output
something after a client has aborted their connection.

See also ignore_user_ahort().

i mplicit_flushboolean

FALSE by default. Changing this toRUEtells PHP to tell the output layer to flush itself
automatically after every output block. This is equivalent to callingriefunctioni flush() after
each and every call io print() or echo() and each and ed&mLblock.

When usingPHPwithin an web environment, turning this option on has serious performance
implications and is generally recommended for debugging purposes only. This value defaults to
TRUEwhen operating under theLI SAPI .

i ncl ude_pat h string

Specifies a list of directories where the require(), include()fapen_with_path() functions look
for files. The format is like the system’s PATH environment variable: a list of directories separated
with a colon in UNIX or semicolon in Windows.

Example 4-3. UNIX include_path

include_path=.:/home/httpd/php-lib

Example 4-4. Windows include_path

include_path="_;c:\www\phplib"

The default value for this directive is(only the current directory).

| og_errors boolean
Tells whether script error messages should be logged to the server’s error log. This option is thus
server-specific.

magi c_quot es_gpc boolean

Sets the magic_quotes state for GPC (Get/Post/Cookie) operations. When magic_quotes are on, all
" (single-quote), " (double quote), \ (backslash) and NUL’s are escaped with a backslash
automatically. If magic_quotes_sybase is also on, a single-quote is escaped with a single-quote
instead of a backslash.
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magi ¢_quot es_runt i me boolean
If magi c_quot es_runti nme is enabled, most functions that return data from any sort of
external source including databases and text files will